Shelly Cashman: Microsoft Excel 2019

Module 2: Formulas, Functions, and Formatting




U0,

Objectives (1 of 2)

* Use Flash Fill

* Enter formulas using the keyboard

* Enter formulas using Point mode

* Apply the MAX, MIN, and AVERAGE functions
* Verify a formula using Range Finder

* Apply a theme to a workbook

* Apply a date format to a cell or range
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Objectives (2 of 2)

* Add conditional formatting to cells

* Change column width and row height

* Check the spelling on a worksheet

* Change margins and headers in Page Layout view

* Preview and print versions and sections of a worksheet




Project: Worksheet with Formulas and

U0,

Functions
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4 | Altore, Benie baltore@example.com 3 3525 $§ 262613 % 66551 5§ 14444 3084% $ 1.8lal8 9/5/10
5 |Fox, Linda Hox({Dexample.com 1 33.10 2,648.00 682.72 145.64 31.28% 1,819.64 10/17/12
6 |Handfield, Jermaine jhandfield@example com 0 28.65 2,055.64 53447 113.06 31.50% 1,408.11 2213
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Table 1: A Salary Report Worksheet 4




Entering the Titles and Numbers into the

L

Worksheet (1 of 2)

* To Enter the Worksheet Title and Subtitle
 Run Excel and create a blank workbook

* Select cell A1 and type the desired worksheet title (Klapore
Engineering), then press the DOWN ARROW key to enter it

* Select cell A2 and type the worksheet subtitle (Salary Report)
then press the DOWN ARROW key to enter it

* To Enter the Column Titles

* Select cell A3 and type the desired text, then press the RIGHT
ARROW key to enter the column heading

* Continue until all the columns you desire have headings

(Employee, Email Address, Dependents, Hours ALT+ENTER

Worked, Hourly ALT+ENTER Pay Rates, Gross Pay, Federal Tax,
State Tax, Tax %, Net Pay, Hire Date) .




Entering the Titles and Numbers into the

Sﬁ Worksheet (2 of 2)

* To Enter the Salary Data

* Select cell A4, type desired name (Altore, Benie), and then
press the RIGHT ARROW key two times to enter the
employee name and make cell C4 the active cell

* Type a number (3) in cell C4 and then press the RIGHT
ARROW key

* Type a number of hours worked (74.50) in cell D4 and then
press the RIGHT ARROW key

* Type an hourly rate (35.25) in cell E4
* Click cell K4 and type a date (9/5/10)
* Use the data in Table 2-1 to enter salary data in a worksheet
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U0,

Flash Fill (1 of 2)

* To Use Flash Fill — automatically fills or formats data in
remaining cells based on patterns of previous cells

* Click a cell (B4)

* Type desired text (baltore@example.com) and then press
the DOWN ARROW to select the next cell (B5)

* Type desired text (Ifox@example.com) again following the
same pattern (for example an email address)

 Click Data on the ribbon to select the Data tab

* Click Flash Fill (Data tab | Data Tools group) to enter
similarly formatted text (email addresses in cells B6:B12)

e Delete entries in cells B1:B2
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Flash Fill (2 of 2)

* To Enter the Row Titles
* Select a cell in the A column (A13:A16)

* Type desired text and then press the DOWN ARROW key to
enter a row header (Totals, Highest, Lowest, Average)

e Continue until all Rows have a header

* To Change the Sheet Tab Name and Color

* Double-click the Sheet1 tab and enter the desired text (Salary
Report) as the sheet tab name and then press the ENTER key

* Right-click the sheet tab to display the shortcut menu

* Point to Tab Color on the shortcut menu to display the Tab Color
gallery. Click desired color { Blue, Accent 1 (col 5, row 1) }

* Save the workbook




Entering Formulas (1 of 5)

U0,

* To Enter a Formula Using the Keyboard

* With the cell to contain the formula selected (F4), type the
formula (=d4*e4) in the cell to display the formula in the
formula bar and in the current cell and to display colored
borders around the cells referenced in the formula

* Press TAB to complete the arithmetic operation indicated
by the formula, to display the result in the worksheet, and
to select the cell to the right
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Entering Formulas (2 of 5)
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o Entering Formulas (3 of 5)

* Arithmetic Operations and Their Order of Operations

* From left to right
-First negation (-)
-Then percentages (%)
-Then all exponentiations (#)
-Then all multiplications (*) and divisions (/)
-Finally all additions (+) and subtractions (-)

-11-



2 Entering Formulas (4 of 5)

* To Enter Formulas Using Point Mode

* With the cell that is to contain the formula selected (G4), begin
typing the formula and then click another cell to add a cell
reference in the formula { 0.26*(F4-C4*22.16) }

* Finish typing the rest of the formula { H4 = 0.055*F4,
14=(G4+H4)/F4, J4=F4—-(G4+H4)}

* Click the Enter box in the formula bar when you have finished
entering the formula
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U0,

Entering Formulas (5 of 5)

* To Copy Formulas Using the Fill Handle

* Select the source range (F4:J4), point to the fill handle,
drag the fill handle down to desired location, and continue
to hold the mouse button to select the destination range
(F5:J12)

* Release the mouse to copy the formulas to the destination

range
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U0,

Option Buttons (1 of 3)

Excel displays option buttons to indicate that you can complete
an operation using automatic features.

Table 2-4 Option Buttons in Excel

Name

Menu Function

Auto Fill Options

Provides options for how to fill cells following a fill
operation, such as dragging the fill handle

AutoCorrect Options

Undoes an automatic correction, stops future
automatic corrections of this type, or causes Excel to
display the AutoCorrect Options dialog box

Insert Options

Lists formatting options following an insertion of
cells, rows, or columns

Paste Options

Specifies how moved or pasted items should appear
(for example, with original formatting, without
formatting, or with different formatting)

Trace Error

Lists error-checking options following the

assignment of an invalid Tormula to a cell
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U0,

Option Buttons (2 of 3)

* To Determine Totals Using the AutoSum Button
* Display the Home tab

* Select the desired cell to contain the sum (D13), click the
AutoSum button (Editing group) to sum the contents of the
range (D4:D12) and click ENTER to display the total in the
selected cell

* Select the range to contain the sums (F13:H13). Click the
AutoSum button to display totals in the selected range

* Select the cell to contain the sum (J13), click the AutoSum
button to sum the contents of the range and click ENTER

-15-



Option Buttons (3 of 3)

U0,

* To Determine the Total Tax Percentage

* Select the cell to be copied (I12) and then drag the fill
handle down through the desired cell (I113) to copy the
formula
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Using the AVERAGE, MAX, MIN, and other

U0,

Statistical Functions (1 of 6)

* To Determine the Highest Number in a Range of
Numbers Using the Insert Function Dialog box

* Select the cell to contain the maximum number (C14)

* Click the Insert Function button in the formula bar to
display the Insert Function dialog box

* If necessary, scroll to and then click MAX in the Select a
function list

* Click the OK button to display the Function Arguments
dialog box and type the cell range (C4:C12) in the Numberl
box to enter the first argument of the function

* Click the OK button to display the highest value in the
chosen range in the selected cell

- c—

—_—
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Using the AVERAGE, MAX, and MIN

U0,

Functions (2 of 6)

* To Determine the Lowest Number in a Range of
Numbers Using the Sum Menu

e Select cell (C15) that is to contain the minimum value and
then click the AutoSum arrow in the HOME tab

* Click Min to display the MIN function in the formula bar
and in the active cell

* Drag through the range (C4:C12) of values of which you
want to determine the lowest number

* Click the Enter box to determine the lowest value in the
range and display the result in the formula bar and in the
selected cell

-18-



Using the AVERAGE, MAX, and MIN

i
s Functions (3 of 6)

Display of selected range appearing in the formula bar and active cell
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Using the AVERAGE, MAX, and MIN

i
s Functions (4 of 6)

* To Determine the Average of a Range of Numbers Using
the Keyboard

* Select the cell (C16) that will contain the average

* Type =av in the cell to display the Formula AutoComplete list
Press the DOWN ARROW key to highlight the required
formula (AVERAGE)

* Double-click AVERAGE in the Formula AutoComplete list to
select the function

* Select the range (C4:C12) to be averaged to insert the range
as the argument to the function

* Click the Enter box to compute the average of the numbers
in the selected range and display the result in the selected
cell -
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Using the AVERAGE, MAX, and MIN

i
s Functions (5 of 6)

Display of Formula AutoComplete list and AVERAGE function name
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U0,

Using the AVERAGE, MAX, and MIN

Functions (6 of 6)

* To Copy a Range of Cells across Columns to an Adjacent
Range Using the Fill Handle

* Select the source range (C14:C16) from which to copy the
functions

* Drag the fill handle in the lower-right corner of the
selected range through the desired selection cell to copy
the functions to the selected range (through J16)

*Select cell 116 and delete the average of Tax % which is
mathematically invalid
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U0,

Verifying Formulas using Range Finder

* To Verify a Formula Using Range Finder
* Double-click a cell (14) to activate Range Finder

* Press the ESC key to quit Range Finder and then click
anywhere in the worksheet to deselect the current cell
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Formatting the Worksheet (1 of 15)
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13 | Totals 616.75 $18413.78 § 471268 § 101276 31.09% $ 12,688.34
i
14 Highest 3 80.00 $41.02  $2,648.00 $68272  $14564 31.50%  $1.823.89
15 |Lowest 0 4225 31800  $1,080.00 $26928 $59.40 3043%  $751.32
16 |Average 1444444444 68.53 $2953  $204598 $52363  $11253 $1,409.82

(b) Formatted Worksheet
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o Formatting the Worksheet (2 of 15)

* To Change the Workbook Theme

* Click the Themes button on the PAGE LAYOUT tab to
display the Themes gallery

* Click the desired theme (Gallery, #3) in the Themes gallery
to change the workbook theme

Page Layout tab

Page Layout Formulas Data Review Viewr Help L Tell me what you want to do

Themes button :IlJ S SC_EX_ 2 Kapore - Savad

Home Insert Draw

I colors~ @ ‘\ ]D P 5 B _fE TIwidth:  Automatic | Giiclines | Headings !
| ¥ Fgpe 9 = |
N . .
heme

Height Automatic ~
The (Al Fonts - Margins Onentahon Size Pn Gallery t Print Lreig 0 View | (4] View Bring Send S

(@] Effects~ Tites | [R]Scale  |100% [ pint | [ Print  Forward - Backward -

Otflt% / ol E sale to Fit % SheetOptlons
Aa I Aa wj Aa 1 A %]
snsmun ] | essman | [ cssses = o ' , 5 . K | e | owm | w

Offlce Facet Gallery Integral R

; r T < Themes gallery (your
1 Aa 1 Aa \}. Aa 1 themes may differ)

Gross Pay Federal T State Tax Tax % NetPay Hire Date
i 2626125 665.5077 144.4369 0.308418 1816.18 9/5/2010
2648 682.7184  145.64 0.312824 1819.642 10/17/2012
i 2055.638 534.4658 113.0601 0.315 1408.112  2/2/2013
1080 263.2768 59.4 0.30433 751.3232 1/15/2016
) 1054.275 278.7439 60.18513 0.309735  755.34 5/18/2012
v 1662713 432.3053 91.44919 0.315 1138.958 5/24/2013
2600 658.7152 143 0.308352 1798.285 11/11/2011
! 2645.79 676.3822 145.5185 0.310645 1823.839 4/23/2006
i 200124 514.5608 110.0682 0.312121 1376.611 9/22/2017
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o Formatting the Worksheet (3 of 15)

* To Format the Worksheet Titles

* Display the Home tab. Select the range (A1:K1) & (A2:K2) to be
merged, click MERGE & CENTER

* Select the range (A1:A2) to contain the Title cell style, click Cell

Styles button to display the Cell Styles gallery and choose a

style (Title)

 Select A2 and click “Decrease Font Size” button (Font group)

Cell Styles

button

File Home a age Djyout  fFormulas
&E %z:t ) Gill Sans MT - - | AT AT - B WrapText /| Genera @
Paste < Py ' B 2 ik . $ o % 9 < 08 Conditignal Formatas Cell Ins|
v < Format Painter Formatting~ Table~ Styles~
Clipboard F} font size of worksheet 7] Alignment [F} Number Styles
subtitle decreased
A2 &3 Sarary Report
A B C D E F | G H | J K L M
I Klapore Engineering :> PR aITN
Sa!ary Report rows merged
Hours Hourly
3 |Employee Email AddriDependentWorked Pay Rate Gross Pay Federal Ta:State Tax Tax % Net Pay  Hire Date
- | 4 VAItore. Ben baltore(@e> 3 74.5 35.25 2626.125 665.5077 144.4369 0308418 1816.18 9/5/2010
5 VFox. Linda lfox@exam | 80 331 2648 682.7184 145.64 0312824 1819.642 10/17/2012
6
. =

7Handﬁeld,]'handﬁeld§a 0 7175 28.65 2055.638 534.4658 113.0601 0315 1408.112 2/2/2013




o Formatting the Worksheet (4 of 15)

* To Change the Background Color and Apply a Box
Border to the Worksheet Title and Subtitle
* Select the range (A1:A2) to color and then click the Fill

Color arrow (HOME tab | Font group ) to display the Fill
Color gallery

* Click a color (Indigo, Accent 5, Lighter 80%) (col 9, row 2) to
select it and change the background color of the cells

* Click the Borders arrow (HOME tab | Font group) to display
the Borders gallery

* Click a border (Outside Borders) in the Borders gallery to
select it and display a border around the selected range

- c—

. et
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o Formatting the Worksheet (5 of 15)

* To Apply a Cell Style to the Column Headings and
Format the Total Rows

* Select the range (A3:K3) to be formatted

* Use the Cell Styles gallery (Home tab | Styles group) to
apply the cell style (Heading 3)

* Click the Center button (Home tab | Alignment group) to
center the column headings

* Apply the Total cell style to the range (A13:K13)
* Bold the range (A14:A16)
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U0,

Formatting the Worksheet (6 of 15)

* To Format Dates and Center Data in Cells
* Select the range (K4:K12) to contain the new date format

* On the HOME tab in the Number group, click the Dialog Box
Launcher (lower right) to display the Format Cells dialog box

* If necessary, click the NUMBER tab and click Date in the
Category list, and then click a date type (3/14/12) to choose the
format for the selected range

e Click the OK button to format the dates in the current column
using the selected date format style

* Select the range (C4:C16) to be centered and then click the
Center button (HOME tab | Alignment group) to center the data
in the selected range
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U0,

Formatting the Worksheet (7 of 15)

*To Apply an Accounting Number Format and Comma
Style Format Using the Ribbon

* Select the range (E4:H4) to contain the accounting number
format

* While holding down the CTRL key, select the nonadjacent
ranges and cells (J4, F13:H13, J13)

* Click the “Accounting Number Format” button (HOME tab
| Number group) to apply the accounting number format
to the selected nonadjacent ranges

* Click the “Comma Style” button (HOME tab | Number
group) to assign the Comma style format to the selected
range (E5:H12, J5:J12, D4:D16) |

——
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o Formatting the Worksheet (8 of 15)

* To Apply a Currency Style Format with a Floating Dollar
Sign Using the Format Cells Dialog Box
* Select the range (E14:H16, J14:J16) to format and then on

the HOME tab in the Number group, click the Dialog Box
Launcher to display the Format Cells dialog box

* |If necessary, click the NUMBER tab to display the Number
sheet

* Click Currency in the Category list to select the necessary
number format category, Click S in the Symbol list and then
tap or click a style in the Negative numbers list to select the
desired currency format ($1,234.10)

* Click the OK button to assign the currency style format to the
selected ranges
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Formatting the Worksheet (9 of 15)

U0,

* To Apply Percent Style Format and Using the Increase
Decimal Button

* Select the range to format (14:115)

* Click the Percent Style button (HOME tab | Number group)
to display the numbers in the selected range as a rounded
whole percent

* Click the Increase Decimal button (HOME tab | Number
group) two times to display the numbers in the selected
range with two decimal places
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Formatting the Worksheet (10 of 15)

U0,

* To Apply Conditional Formatting

* Select the range (D4:D12) to which you wish to apply
conditional formatting (a value > 70 will appear with a
purple background and a white font)

* Click the Conditional Formatting button (HOME tab |
Styles group) to display the Conditional Formatting menu

* Click New Rule in the Conditional Formatting menu to
display the New Formatting Rule dialog box

* Click the desired rule type (Format only cells that contain)
in the Select a Rule Type area

* Select and type the desired values in the Edit the Rule
Description area (2" box: greater than, 3" box: 70)
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Formatting the Worksheet (11 of 15)

U0,

* To Apply Conditional Formatting (continued)

* Click the Format button (New Formatting Rule dialog box)
to display the Format Cells dialog box

* If necessary, click the font tab (Format Cells dialog box)

* Click the Color arrow to display the Color gallery and then
click White Background 1 (col #1, row #1) to select the font
color

* Click the Fill tab (Format Cells dialog box) and click the
purple color (col #8, row #1) to select the background color

* Click OK (Format Cells dialog box)
* Click OK (New Formatting Rule dialog box)

- c—
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S Formatting the Worksheet(12 of 15)

Table 2-5 Summary of Conditional Formatting Relational Operators

Relational Operator

Formatting will be applied if...

Between

cell value is between two numbers

not between

cell value is not between two numbers

equal to

cell value is equal to a number

not equal to

cell value is not equal to a number

greater than

cell value is greater than a number

less than

cell value is less than a number

greater than or equal to

cell value is greater than or equal to a number

less than or equal to

cell value is less than or equal to a number
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& Formatting the Worksheet (13 of 15)

* To Change Column Width
* Drag through column headings (A, B, C) to select the columns

* Point to the boundary on the right side of column heading to
cause the pointer to become a split double arrow

* Double-click the right boundary of the column to change the
width of the selected columns to best fit

* To resize a column (H) by dragging, point to the boundary of
the right side of the column heading. When the mouse
pointer changes to a split double arrow, drag to the desired
width (ScreenTip: 10.38 / 88 pixels), and then lift your finger
or release the mouse button to change the column widths

o —

- ——————e
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& Formatting the Worksheet (14 of 15)

* To Change Column Width (Continued)

* Click and drag column D, E & | headings above row 1 to select
these nonadjacent columns

* Point to the right side of the column | heading boundary

* Drag until ScreenTip shows Width: 10.50 (89 pixels) and then
release the mouse button

* Click and drag column headings (F, G, J & K) to select these
nonadjacent columns

* Drag the boundary on the right side of the column G until the
ScreenTip indicates Width: 11.13 (94 pixels)

* Release the button to change the column widths

- c—

. et
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Formatting the Worksheet (15 of 15)

U0,

* To Change the Row Height

* Point to the boundary below the row heading (3) to resize
until the pointer becomes a split double arrow

* Drag the boundary to the desired row height (ScreenTip:
39.00 / 52 pixels) and then release the mouse button

e Lift your finger or release the mouse button to change the
row height

* Do the same for row heading (14) to change the row height
to ScreenTip: 24.00 (32 pixels)

-38-



U0,

Checking Spelling

* To Check Spelling on the Worksheet

* Click cell A1 so that the spell checker begins at the
beginning of the worksheet

* Click the Spelling button (REVIEW tab | Proofing group) to
run the spell checker and display the misspelled words in
the Spelling dialog box

* Apply the desired action to each misspelled word
* When the spell checker is finished, click the Close button
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O Printing the Worksheet (1 of 3)

* To Change the Worksheet’s Margins, Header, and Orientation in Page
Layout View

* Click the Page Layout button on the status bar to view the worksheet in Page
Layout view

* Click the Margins button (PAGE LAYOUT tab | Page Setup group) to display the
Margins gallery

* Click the desired margin style (Narrow) to change the worksheet margins to
the selected style

* Click above cell A1 in the center area of the Header area

* Type the desired worksheet header (Madelyn Samuels + ENTER + Chief
Financial Officer), and then deselect the header

* Click the “Orientation” button (PAGE LAYOUT tab | Page Setup group) to
display the Orientation gallery

* Click the desired orientation (Landscape) to change the orientation
* Double click the borders of column headings F & J to best fit the columns
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Printing the Worksheet (2 of 3)

L

* To Print a Worksheet
* Click FILE on the ribbon to open Backstage view
* Click the Print to display the Print screen

* If necessary, click Printer Status button to display a list of
available printer and click the desired printer

* Click the No Scaling button and then select “Fit Sheet on
One Page”

* Click Print
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Printing the Worksheet (3 of 3)

* To Print a Section of the Worksheet
* Select the range to print (A3:F16)
* Click FILE on the ribbon to open Backstage view
* Click the Print to display the Print screen

* Click “Print Active Sheets” in the Settings area on the
PRINT screen to display a list of printing options

* Click Print Selection to print the selected range

* Click the Print button in the Print screen to print the
selected range of the worksheet

* Click the Normal button on the status bar to return to
Normal view
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Displaying and Printing the Formulas Version

gﬁ of the Worksheet (1 of 2)

* To Display the Formulas in the Worksheet and Fit the
Printout on One Page

* Press CTRL+ACCENT MARK (°) to display the worksheet with
formulas

* Click the Page Setup Dialog Box Launcher (PAGE LAYOUT tab |
Page Setup group) to display the Page Setup dialog box

* If necessary, click the Landscape Orientation in the Page sheet
* If necessary, click Fit to in the Scaling area to select it

* Click the Print button to open the Print screen in Backstage view.
Select the Print Selection button in the Settings area of the Print
gallery and then click Print Active Sheets

* Click the Print button to print the worksheet

 After viewing and printing the formulas version, press
CTRL+ACCENT MARK (°) to display the values version
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Displaying and Printing the Formulas Version

Sﬁ of the Worksheet (2 of 2)

* To Change the Print Scaling Option Back to 100%

* Click the Page Setup Dialog Box Launcher on the PAGE
LAYOUT tab to display the Page Setup dialog box

* Click the Adjust to option button in the Scaling area to
select the Adjust to setting

* If necessary, type 100 in the Adjust to box to adjust the
print scaling to 100%

* Click OK
* Display the Home tab
* Save the workbook, sign out and exit Excel
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